In this second part of a 2-part series, we explore the rest of the Navisworks Manage 2012 feature set: Animator, Scripter, and Presenter, which together bring compelling project visualization and virtual design analysis capabilities to your construction models. Using the Animator, we create animations of model elements. Scripter allows us to trigger animations and other events for simulation and presentation purposes. Using Presenter, we easily create stunning photorealistic imagery of our projects. We can then combine our animations with the Clash Detective and TimeLiner to identify spatial conflicts in the construction schedule itself and enhance our simulation visualization.

Learning Objectives

At the end of this class, you will be able to:

• Create Animations of model items.

• Add scripts that react to program and user events to create intelligent, event-based animations.

• Use the Presenter to easily create stunning photorealistic visualization of your project model.

• Apply your animations in the TimeLiner to better visualize the construction process over time.

• Add animated TimeLiner data to the Clash Detective to identify construction site workflow and scheduling conflicts

About the Speaker:

Matt is the senior AEC applications and building information modeling (BIM) implementation technical specialist for CADapult Ltd., an Autodesk Silver reseller in the Mid-Atlantic region. Matt specializes in Revit® training and BIM implementation for design firms and the construction industry. He has over 20 years’ experience as a CAD and IT Manager for several A/E firms in Delaware, Pennsylvania, and Boston, Massachusetts, and has been using Autodesk® software since 1987.

matt.stachoni@cadapult.net
matt@stachoni.com
http://www.cadapult.net/aecblog/
Class Notes

This is Part 2 of a two-part class. In the first session, **CR4801 BIM for Contractors: An Introduction to Autodesk Navisworks Manage 2012 Part 1**, we discussed the primary functionality of Navisworks, including the user interface, appending files together, managing data, optimizing graphics, using the Design Review toolset, and using the Clash Detective and TimeLiner modules. If you did not attend the first session, please visit the class session page on the Autodesk University web site and download the course materials and datasets.

In this class session we will focus on the Animator, Scripter, and Presenter modules, adding animations to your TimeLiner simulations, and combining animations, TimeLiner, and Clash Detective to provide a complete 4D time-based analysis of your construction site.

While this class is not a lab per se, the material provided will be somewhat tutorial based, and there will be datasets available at the AU web site for this class that you can download and use.

Animator

Introduction

Navisworks’ **Animator** module provides the ability to create animations, which are prepared sequences of changes to objects in the model. For example, you can animate building components being erected, crane boom operations, doors opening and closing, and dump trucks entering and leaving the job site.

You can make three major kinds of animations:

- Manipulate *object transforms* (move, rotate and scale) and object visibility (color and transparency). This package of changes is referred to an **Animation Set**, which records the geometry to be animated and a list of keyframes which describe how it is to be animated.

- Manipulate *viewpoints* via navigation tools (walk/fly/orbit) or by using existing viewpoint animations. This type of change is called a **Camera Animation**.

- Manipulate *cross sectional cuts* of the model by moving section planes or a section box. This type of change is referred to a **Section Plane Set Animation**.

These three animation types are all saved in a container called a **Scene**. Inside a scene you create one or more Animation Sets (scenes can have as many animation sets as desired), a single camera animation and a single section plane animation. You can have as many scenes as you need in a Navisworks model file.

Animations are often tied to Animation Scripts using the Scripter module. A Script is a definition of an Event trigger, such as an avatar collision with a door, with an Action, such as an animation of the door opening. We cover Scripter later in this document.
Supported Animation Types
Navisworks Manage 2012 supports object animation and object interaction as follows:

- Animation specified by keyframes with or without linear interpolation between keyframes;
- Camera, section plane, and object animation;
- Multiple independently moving objects being independently started;
- Multiple animations of the same object in the same scene; e.g. moving a crane, then lifting its arm;
- Simple event-drive scripts that can trigger an animation;
- Linking animations to TimeLiner tasks to trigger independent animations as tasks start, such as the driving of foundation piles or erection of steel on the fifth floor;
- Linking a single animation to TimeLiner with different TimeLiner tasks playing to specific points in an animation. For example, have a single animation that moves a crane between all points on a site, then have any task trigger the animation to move the crane from its current point to the desired point;
- Linking animations to Clash Detective to run clash tests at specific steps through an animation to check for animated vs. animated or animated vs. static object clashes.

The following is not supported in Navisworks Manage 2012:

- Animation specified by anything other than objects, for example a spline or path.
- Animation of lights;
- Moving a whole object and creating an independent trigger to move part of an object, e.g. animating the movement of a whole crane and have a button that triggers the arm moving at a point;
- Scripted animations that do not require a separate animation/script for each component part being animated. There are no cut and paste capabilities in scripting;
- Linking to TimeLiner and having different TimeLiner tasks trigger animations that depend on each other; for example, one task moves a crane to a specific point, another task moves the arm of the crane.
- Real time collision checking that stops when a moving object stops when it first hits something.

After you create your first few animations, you discover how easy it is to create complex animations because the basics are all the same. The Animator and Scripter interfaces are somewhat less complex than TimeLiner or Clash Detective and are easy to learn. This handout will cover the basic ideas and workflows. Please consult the Navisworks Help file for information on specific controls and options.
About Keyframes
In animation lingo, a “Keyframe” is a snapshot of your objects’ position and visibility at a certain point in time. It is used to define position and properties of the changes made to the model. Back during olden times, filmmakers used stop-motion techniques for animation. They positioned a model, and shot a frame; made a tiny adjustment, shot another frame. 24 of those frames made one second of film.

To make sure the animations hit their intended targets, animators defined “keyframes” that put the model be in a certain position at a particular point in time, and worked towards those targets as they positioned/shot each frame between the keyframes.

This workflow has remained essentially unchanged, regardless of technology used, except you do not need to animate each frame. Instead, you position the items at the desired time, capture a keyframe, and the Animator records that position and visual state information in the keyframe itself. Upon playback, it will interpolate the motion and any change of visual state of the object between the keyframes.

About Cameras and Viewpoints
In an Animator Scene, a Camera contains a series of viewpoints and an optional set of keyframes to describe how the viewpoints move over time. If no camera or camera keyframes are defined, the animation will use the current Scene View viewpoint, which can be changed by the user at any time during animation playback. If a single keyframe is defined, the camera will move to that viewpoint and then remain static throughout the animation. If multiple keyframes are defined, the camera (and thus your view) is animated accordingly.

In effect, this allows you to “direct” your animated scenes to a high level and create professional looking animations. You can focus on one set of items as they animate to show off a particular event or condition.

Each Scene can only have one camera in it. You start by adding a blank camera, then manipulate the viewpoints or copy an existing viewpoint to the camera. Then create the desired keyframes.

The Animator Window
The Animator is a dockable horizontal window that is composed of four main areas.
At the top, the **toolbar** has tools for transforming (moving / rotating / scaling) objects, capturing keyframes, setting the current Scene time slider, and controlling playback.

Below the toolbar on the left side is the **Scene Tree View** that lists all of the Scenes and their respective animation sets, camera animations, and section plane animations in a hierarchical list. You can add, delete, and reorder scenes and animation sets using the add/remove controls at the bottom.

To the right is the **Timeline** view, which shows the animation timeline with the keyframes for each of the animation sets, cameras, and section planes in the scene. At the top is the timescale bar, which shows the current timescale in seconds. The black vertical bar is the Time Slider, which represents the current playback position (as also indicated in the Toolbar). Animation bars are the horizontal colored stripes which represent the transformations occurring for that scene tree element. Each animation type is shown in a different color. Black diamonds indicate individual keyframes. At the bottom of the Scene Tree view are zoom controls for the Timeline View.

At the bottom is the **Manual Entry** bar for manipulating geometry by typing in numbers instead of using gizmos in the Scene View. You can also modify color and transparency using controls that will appear in this area.

**The Animator Toolbar**

The Animator Toolbar has tools for modifying the object’s transform (move, rotate, scale), color and transparency. When you select an object in the Scene View and click one the transform tools, a gizmo will appear on the object with handles that you can use to interactively move, rotate or scale the object. Alternatively you can use the Manual Entry area at the bottom to enter values.

The Capture Key Frame button takes a snapshot of the current state of the Animation Set’s selected items, and creates a new keyframe at that time position in the timeline view. The Toggle Snaps button provides snapping control when manipulating the transform gizmos in the Scene View.

The Time edit box controls the current position of the time slider in the timeline view. Although you can interactively mode the time slider with the mouse, it is particularly helpful to be able to dial in the correct time in this box.

The playback controls plays, rewind, fast forwards, and pauses the active scene animation across the timeline.
Animator Scene Tree View

The Animator tree view lists all of the scenes and scene components (animation sets, camera animation, and section animation) in a hierarchical view. It is used to build and manage your animation scenes.

You can select scene and scene components, and use context menus to add scenes, animation sets, camera, section plane, folders, cut/copy/paste, and so on. The icons below add and remove components and reorder scenes in the tree view, and zoom the timescale bar up and down.

The check boxes controls the corresponding item as Active – only active scenes will play – and whether it loops, ping-pongs, and if it should run indefinitely. Animations typically stop at the end of the timeline.

Looping and Ping Pong are available for scenes and scene animations and control playback mode when the animation reaches the end. Loop will reset the animation back to the start and play it again. Ping Pong (P.P.) will play the animation to the end; it will run backwards until it reaches the start. Infinite will make the scene play indefinitely until the Stop button is clicked.

As you work with your object animations, you will undoubtedly need to organize them in some fashion. You can group scenes and scene components into two types of folders. **Scene folders** can store entire scenes and other scene folders. **Folders** can store scene components and other folders.
**Timeline View**

The Timeline View shows the timeline for each animation set, camera, and section plane in a scene. It is used to visualize and edit the animation along its timeline. A timeline has a colored animation bar which is used to visualize the duration of an animation of a scene component. Cameras show a green bar, animation sets in blue, and section plane sets in red. The animation start and end times can be edited by dragging the solid diamond shaped keyframes at each end of the animation bar.

Keyframes are shown as black-filled diamonds in a timeline; they turn white when the time slider passes over them. Keyframes have context menus to edit, cut, copy, paste, delete them, and an interpolate checkbox to determine if the animation interpolates itself between keyframes or if it instantly jumps to the second keyframe.

The timeline bar at the top of the timeline view shows the time scale displayed in seconds. You can zoom in and out of this scale using the Zoom buttons in the interface. Each timeline starts at zero.

The time slider is the black vertical line that represents your current time position in the animation timeline. You can drag the time slider back and forth (called “scrubbing”) or use the time edit box in the toolbar to set it exactly. As the time slider is moved, animated objects in the current scene update as if the animation were playing back.

The red vertical line at the right is the end slider, representing the end point of the current active scene. This is hidden if the “Infinite” check box is checked for the current scene in the scene view.

You can right-click on a keyframe and select Edit to access its properties; you can make exact changes to the time, the translation of the selected objects, their color and transparency, and other settings. This is perhaps the easiest, most efficient way of fine tuning your animations, because you are editing those properties at that exact moment in the animation.
Animation Creation Tutorial

Let’s cover the process of adding an animation to two sets of double doors at the entry vestibule of a building. Download the datasets for this class and open the file “RAC Sample Project.nwf.”

Setting up the Animation Scene

1. For convenience, start by restoring the Entry Start saved viewpoint. You should be facing the set of double glass doors at the entry of the building. Bring up the Animator window and pin it into place.

2. In the empty Animator window, click the green Add (+) button at the bottom and select Add Scene. Click on the new scene, and rename it “Opening Doors.”

3. Select the Opening Doors scene, and click the Add (+) button > Add Camera > Blank Camera. A camera should now be displayed under the Opening Doors scene and set active.
4. Click to select this camera, and click Capture Keyframe on the toolbar. This captures the camera at this current view and places the keyframe at the beginning of the camera timeline.

5. Right-click on the open black diamond, and select Edit to review the parameters of the keyframe:

![Edit Key Frame dialog box](image)

6. We need to be able to select the geometry at the deepest level, so in the scene view, with nothing selected, right click in the Scene View and select “Set Selection Resolution to Geometry.”

7. In the scene, ensure you are in object selection mode (hit CTRL+1) and select the left door’s left glass pane and, holding the CTRL key down, select the door outer frame and the handle.

8. In the Animator, select the scene Opening Doors, click Add (+) > Add Animation Set > From Current Selection. Click the new animation set and rename it “Outer Left Door.” This new animation set is assigned to work on the outer left door objects.
9. Repeat steps 6 and 7 to add and Animation Sets for the Outer Right Door

10. Use the Walk tool (CTRL+2) to walk into the vestibule (between the sets of doors) and create Animation sets for the Inner Left Door and Inner Right Door. As you add the left door Animation Set, you will in the process restore the Camera viewpoint, so you will have to walk inside the vestibule again to select the right door objects.

**Editing the Camera and Camera Viewpoints**

1. You’ve already added the camera and created the initial keyframe at the current viewpoint. We’ll now set up a walkthrough by adding additional keyframes to the camera animation.

2. Select the Opening Doors Scene which restores the initial Camera view. Select the Camera in the Scene. In the timeline view, either drag the black time slider to around 8 seconds, or use the time slider edit box in the toolbar to enter it exactly. The scene does not change.

3. Use the Walk navigation tool (CTRL+2) to walk towards the building until you are between the outer and inner doors. Make sure you have collision turned off.

4. Click Capture Keyframe on the Animator toolbar to add a keyframe at this point. This captures a keyframe at the current view and places it at the current camera timeline. A green band representing the camera animation connects the two keyframes.

5. In the timeline view, set the black time slider to 13 seconds.

6. Walk through the second set of double doors into the lobby, and click Capture Keyframe.

7. In the timeline view, set the time slider to 18 seconds.

8. Use the Navigation Wheels > Look tool to spin around to the right to view the doors you have just walked through, and walk backwards at the same time to see the doors in their entirety. Click Capture Keyframe.

9. Set the time slider to 22 seconds.

10. Walk backwards a few paces and click Capture Keyframe.

11. Set the time slider to 28 seconds.

12. Select the Look button on the SteeringWheels and rotate your view towards the stairs on the left.

13. Click Stop and then click Play on the Animator toolbar to view the animation you have created. You should see yourself walk through the doors (they don’t open – yet), turn around and walk backwards a little bit, and then turn left towards the stairs.

**Manipulate the Geometry**

1. In the Animator toolbar, click the double-left arrows to go to the beginning of the animation. You should be back outside at the initial starting view.

2. Uncheck the Active box for the Camera. This temporarily disables the camera / viewpoint animation as we work on animating the doors.

3. Select the Outer Left Door animation set. The left door panel should be selected.

4. Setting up transforms for animations can be tricky. It helps to set the view so that you can see exactly what is happening at all times. With the door selected, hit the Hide Unselected
button in the Home > Visibility panel (or right-click, Hide Unselected). If you get a message box indicating you have selected an object that is instanced multiple times, hit OK.

5. Click the Top view in the View Cube. Due to the orientation of the model, East should be pointing up. Go to Viewpoint tab > Camera panel > Orthographic to remove perspective, so you are seeing essentially the true plan view of the model.

6. It’s a good idea to save this viewpoint for future use; there is one called Door Top already made. Note the icon in the Saved Viewpoints shows this is an orthographic view.

7. Scrub the time slider to 4, or enter 4 in the time position edit box.

8. Click the Rotate Animation set in the Animator toolbar. This will display the Rotate gizmo which represents the center of rotation.

9. Note that it is in the center of the door panel, which is the default location for all gizmos. We need to move it to the corner hinge position, which is the lower left corner. When you animate the transform of model objects, you are essentially animating the gizmo itself which transforms the object. Thus, we need to move this to the hinge point and set the keyframe before we rotate anything. Otherwise, the animation will move the rotate gizmo to the corner while it is rotating the door, producing a distorted rotation.

10. To help with placing gizmos accurately, click the Toggle Snapping magnet tool in the Animator toolbar. Snap the rotate gizmo to the lower left (outer) corner of the door.

11. Click Capture Keyframe to capture a keyframe for that animation set. You will see an open diamond in the Outer Left Door animation set time line. (The keyframes are open diamonds when they are coincident with the time slider).

12. Set the time slider to 7 seconds.

13. Rotate the blue quadrant and door panel to the right -90 degrees, so it is swinging outward. The coordinates in the Manual Entry portion of the Animator window show the Z rotation at minus (−) 90 degrees.
14. Click Capture Keyframe. An open black diamond will appear in the Outer Left Door timeline, and a light blue band will connect the two. Blue bands represent object animations where there is interpolation between the two keyframes.

15. We want the doors to stay open for a certain period of time, so we need another keyframe positioned at the start of the closing animation. Right-click on the second keyframe, and select Copy.

16. Drag the time slider to 18 seconds. Right-click along the Outer Left doors row, and select Paste. This will paste a copy of the initial keyframe somewhere on the timeline. We want it to be right on the 18 second mark, so edit the keyframe, and set the time to 18 seconds.

17. We copied this keyframe because it stores the position and condition of whatever is in the animation set. The “start to close” condition is exactly the same as the “end of opening” condition, so we can copy and paste the keyframe.

18. Right-click on the keyframe at 4 seconds, copy it, and paste it into the timeline sometime after the 18 second mark. Edit the keyframe’s Time parameter to 21 seconds. You should see the door closed.

19. Click the Stop button on the toolbar, and deselect the Rotate Animation Set button.

20. Click on the keyframe at the 4 second mark, and click Play. You should see the door open for 3 seconds, hold open until 18 seconds, then close between 18 and 21 seconds.

21. Restore the Entry Start viewpoint. Because this viewpoint stored the hide/show state of the scene, everything should be turned back on.

22. Repeat the above procedure for the other three door panels, using the same points on the timeline. Translate the right side doors positive (counterclockwise) 90 degrees. Remember the process: Set the time slider first, position the gizmo, and capture the keyframe.

23. Activate the Camera and click Play. The four doors should open.

The completed animation timeline should look as follows:
Manipulating Geometry and Visibility Properties

In the exercise above we used the “Rotate animation set” button to rotate the door in the Z axis using the Translate gizmo. Similarly, we can use the “Translate animation set” and “Scale animation set” buttons to move and scale animation set objects using those gizmos.

For each of these gizmos, we can alter the object by dragging either on an axis or on one of the colored planes between axes, as we did in the rotation above. Selecting on the axis constrains movement to that axis only; selecting the plane between axes transforms along that plane. The selected axis/plane turns yellow.

Similarly, we can use the “Change color of animation set” and “Change transparency of animation set” buttons to modify those properties at those keyframes; change the settings in the Manual Entry area at the bottom.

Inside the keyframe properties, we can also modify the color and visibility (transparency) of the object(s) at that particular point in time. It is often faster to set up keyframes quickly, then edit each one individually and set their properties for X/Y/Z transformation, color, and transparency.

Animating Section Plane Sets

A Section Plane Set contains a list of section planes and a list of keyframes that describe how they move. Each scene can only have one section plane set in it.

Just as we animated a viewpoint and a set of items, we can also animate a section plane or a set of linked section planes. To add a section plane set and capture sectioned views:

1. In the Animator, right-click on the desired scene (or create one), and click Add Section Plane. You are now ready to manipulate section cuts.

2. Select the section plane set. In the Viewpoint tab, enable Sectioning. The Sectioning Tools tab will become available.

3. We are going to use Planes mode in this example. On the Planes Settings panel, select one of the six available the section plane that you wish to manipulate from the drop down.
4. Set the alignment from the drop down list, e.g. Alignment: Top.

5. Click the Planes Settings tool launcher, and in the Section Planes Settings window, make sure that plane is enabled (the box under the light bulb is on) and that the proper alignment is assigned to it.

6. If you wish to link two planes together, select two section planes to be active, configure the second plane’s alignment, and click the Link Section Planes check box in the Planes Settings panel. The two planes will then stick to each other during the animation.

7. In the Sectioning Tools tab > Transform panel, click the Move button to bring up the sectioning plane if it’s not visible. Use the plane gizmo to position it where you want to start the sectioning. You can also use the Transform slider panel to set the values explicitly. **Note:** Those gizmo colors Red, Green and Blue correspond to the X, Y and Z axes of the section plane, respectively. However, the X/Y/Z coordinates in the Transform panel are based on the world coordinate system of the model, and will not match the section gizmo except for a plane whose alignment is Top. It’s a good idea to know which way the positive X/Y/Z axes are; one easy way to do this is to use the ViewCube to go to the Top view, and ensure North is pointing up.

8. Note: When linking section planes, you probably will need to configure the relative positioning of them. To do so, ensure they are both unlinked, then select one plane as current in the Planes Settings panel, and position it correctly in the model, e.g. at Z=0 for a top plane. Use the Transform panel drop-down to examine the properties of the current section plane. Then set the second plane current and repeat the process, giving it a different XYZ value as appropriate for that plane (e.g., Z = -12’). Then link the two section planes. If you modify the position of the second plane after they have been linked, you will necessarily move the first plane.

9. With the time slider at 0, click Capture Keyframe on the Animator toolbar to create a keyframe with the current section cut.

10. In the timeline view, move the time slider to the desired time.

11. Move the section plane gizmo to the desired location of the section plane for that particular time. Use the Sectioning Tools > Transform panel drop down to position the XYZ position of the plane accurately. Click Capture Keyframe to record its position. You’ll notice the section plan set has a red timeline.

12. Repeat these steps to capture additional section plane locations with keyframes, if desired. Note that you can animate a section going through the building with as few as two keyframes for start and stop position.

13. Click Stop then Play to view the animation.
Limitations of Section Plane Animations and Inventive Animation Techniques

As you start to create animations you will no doubt start to experiment with the cinematography of the composition; that is, maximize how the animation actually helps present the overall construction story. Simply animating the building components moving into position takes a lot of steps, as you place initial positions and figure out how to get the movement to look smooth and natural. To get the full effect you will want to add additional model items and animations for construction equipment, fencing, trailers, transparent boxes that represent work packages, and other site items.

One of the rather disappointing aspects of animating section planes is that the section plane cuts through the entire model, not just the items you are animating. When you think of how the erection of the structural steel should appear, you would think that animating the section plane from the first floor up would result in only the columns rising from the base for that particular scene and animation set.

Alas, this is not the case. The section plane is part of the Scene but has nothing to do with the actual Animation Set which defines model objects to animate. As such, it will cut everything else in the model, and you cannot isolate the sectional behavior to just the structure. However, you can utilize some workarounds.

First, if you are trying to get that classic “rising-from-the-ground” kind of animation, you can create an animation that moves the objects from below the grade to their final location. The problem here is that you may see those objects if your viewpoint changes and/or the terrain/grade model is not deep enough.

To fix this, put a non-moving section plane with its alignment set to Bottom (so it points downward), positioned just below the ground plane. Set a single keyframe for this section plane at time = 0 and do not move it. Anything passing through the section plane will be invisible below it.

Another alternative is to place the initial positions of the elements at a high elevation, out of the frame of the camera viewpoint and animate them coming down into position. Also bring them in from the sides, like an assembly. Remember that you can animate not only the movement, but also the transparency. Set the initial position’s keyframe transparency to 0 and the finished position keyframe transparency to 100. Note, however, that if you are linking your animation to a construction schedule in TimeLiner, the color and animation overrides are ignored.

The other effective alternative is to use the Scale transform to scale the structure in the Z-direction up from zero to 1 (100%); this effectively makes them look like they are growing from the ground up. For floor and roof structure, scale along a horizontal plane (X, Y, or both) outward from the center. If you create an animation for each of the structural bays, this can very effectively simulate the building’s structural construction progress.
Notes on Working with Exported Revit Models

In working with the Animator, exported Revit models can pose certain difficulties. For example, when you attempt to animate items inside of a Revit component family, such as the door panels inside of a double door as we did previously, you may not be able to select the left panel geometry separately from the right panel geometry. This means you cannot animate the door opening.

Because native geometry from CAD and BIM applications can be very complex, Navisworks needs to determine how far down the Selection Tree it should process geometry as it is converted. Recall that you have a limited set of Selection Resolution settings: By File, Layer, First Object, and so on. By default, Navisworks will collapse the Selection Tree to Composite Objects.

For components in CAD and Revit files that have many bits and pieces, this has the effect of combining much of that raw geometry into a single selectable item. Normally, this is a good thing, because it lowers the number of items in the Selection Tree and may, sometimes drastically, reduce the number of false clashes in the Clash Detective.

However, in the Animator, this combination of geometry down to Composite Objects means you hit a wall when trying to do things like animate a door opening, because you are not be able to select a single piece of geometry inside the Revit component family to animate.

The solution to this lies is in how the source file is converted when brought into Navisworks. In the Options > Model > Performance dialog, the On Load section has a “Collapse on Convert” option which is typically set to Composite Object. In Revit, the Navisworks NWC exporter provides the same options.

Set this to None to fully expand the tree and gain access to all of the model geometry.
Construction Modeling and Animating Parts

One of the major – and most important – developments for Revit and Navisworks 2012 is the support for construction modeling workflows. In Revit, the new Parts feature allows you to break up the construction of a multi-layered element, such as a floor or wall, into its composite layers. It also allows you to divide the element into smaller parts, so you could, for example, split up a monolithic floor slab into individual pours.

Navisworks 2012 fully supports Parts modeling, which is critical for efficient Navisworks workflows. This single feature should eliminate much of the previously required remodeling of the designers’ models just to get something useful in Navisworks.

When you export Revit models using the NWC Export utility (discussed in Part 1 of this class), ensure you have the Convert construction part” box checked.

In Navisworks, your model will be exported with each of the parts available as individual items listed under the parent element. The part selected on the left is highlighted in bright green in the viewpoint of the animation.
Now that you have access to these individual Parts in Navisworks, you have complete freedom to animate them as you see fit. In the screen shots below, we have animated just one wall to demonstrate the scheduled construction for the wall stud core, sheathing, exterior wood cladding, window units and glazing, and the interior gypsum wall board installation. Each animation Scene is composed of one or more Animation sets for each individual Part.
Scripter

The **Scripter** adds interactivity to your model. Scripts contain definitions for one or more *events*, things that happen in the model or by the user; and *actions*, e.g., play an animation of a set of doors sliding open.

By combining scripts with animations created in Animator, the model animation can be triggered by an event created in Scripter - you don’t have to explicitly fire up an animation to have it run. Script events can be the result of something happening in the model, but also be interactive, that is, an animation triggered by specific user-made events such as a key press or mouse click.

By linking TimeLiner and scripted object animations together, you can trigger and schedule object movement based on start time and duration of project tasks. This is a typical scenario with VDC simulations to help with workspace and process planning. For example, if you have a crane moving across the site, you can see if any workgroups working nearby cause an obstruction along its route.

Linking scripted animations into Clash Detective can check animated versus animated or animated versus static object clashes.

You can link all three – Clash Detective, scripted object animation, and TimeLiner together to provide clash testing of fully animated TimeLiner schedules. Instead of visually inspecting a TimeLiner simulation for conflicts, run a Clash Detective test that links the TimeLiner.

This section will cover the basics of scripting and how to set them up. The final section in this handout will focus on linking scripted object animations, Clash Detective, and TimeLiner together.

**Creating Scripts**

Building scripts is a two part process. You define what things you want to have happen and why they happen, or what causes them to happen. For example, have some doors open as you walk up to them. This collision of your avatar and the door defines an Event, which is the occurrence of an incident or situation that triggers the resultant action. Events are typically things like mouse clicks, key presses, or a collision as in our case with doors. Navisworks defines several event types that you can choose from.

**Event Types**

There are seven event types available: On Start, On Timer, On Key Press, On Collision, On Hotspot, On Variable, and On Animation. Each of these is pretty easy to configure by itself; however, it is when you need to combine them that things can get “interesting.” A brief description of each Event Type is as follows:

**On Start Event**: Triggers a script as soon as scripting is enabled. If scripting is enabled when a file loads, then any start events in that file are triggered immediately. This is useful for setting up initial conditions for your script, such as giving values to variables, moving a camera to a defined start point, and so on. No properties need to be defined for this type.

**On Timer Event**: Triggers a script at predefined time intervals. You can specify interval, regularity, and regularity frequency (one time or continuous).
On Key Press Event: Triggers a script with a specific button on the keyboard. You can specify the key, and how it is triggered on (via key up, key down, or while key pressed).

On Collision Event: Triggers a script when the mouse collides with a specific object. You can specify the object and include the effects of gravity in collision detection, e.g. walking across a floor would trigger the event.

On Hotspot Event: This triggers a script when your mouse is within a certain range of a hotspot. You can specify the hotspot type (a sphere in space, or a sphere around a selection); how the event is triggered (entering, leaving, or in range of the hotspot); specify the position of the hotspot (if its type is Sphere); hotspot objects; and radius of the hotspot in millimeters.

On Variable Event: Triggers a script when a variable meets a predefined condition. You can specify the name of the variable; operand value to be tested against your variable (a number, string, other variable, or Boolean “true” or “false”); and Evaluation, the operator used for variable comparison. Valid operators are Equals, Greater Than, Greater Than or Equals, Less Than, Less Than or Equals, and Not Equal To.

On Animation Event: Triggers a script when a specific animation starts or stops. You can specify the animation and how it will be triggered (on start, or on end).

Script Event Logic
Scripts can have more than one event in them. However, building several events in one script requires forethought because the event structure becomes very important. Events use Boolean logic to determine if something happened, that is, AND/OR statements. You will have to use logic that makes sense, ensuring that brackets are properly closed and so on. Your script will only run when all event conditions in the script are satisfied.

Actions
After you configure your events, you need to create and configure your Actions – what actually takes place when triggered by an event. Scripts can have more than one action in them, but they are executed one after another, so it is important that their order be correct. However, scripts do not wait for one action to complete before moving on to the next action. Like Events, you have several different Action Types to work with.

Action Types
There are eight Action types: Play Animation, Stop Animation, Show Viewpoint, Pause Script, Send Message, Set Variable, Store Property, and Load Model. A description of each is as follows:

Play Animation Action: Specifies which animation should play back when the script is triggered. You can specify the animation, if you want the animation to stop at the end or snap back to the beginning, and when the playback starts and ends (start, end, current position, specified time).
**Stop Animation Action:** Specifies which currently playing animation to stop when a script is triggered. You can specify the animation and how you want the animation to reset itself when stopped.

**Show Viewport Action:** Specifies which viewport to use when a script is triggered.

**Pause Script Action:** As mentioned previously, actions are executed one after another without waiting for one to finish before moving on to the next. The Pause Script action stops the script for a specified amount of time before the next action is run. Alternatively, you can create several scripts to execute actions separately.

**Send Message Action:** Writes a message into a text file when a script is triggered. This can be useful when creating several interactive scripts to test if a particular script is working. The location of the text file is specified under Options > Scripter > Path to Message File.

**Set Variable Action:** Assigns, increases, or decreases a variable value when a script is triggered. You can specify the variable, value and assignment operator (Set Equal To, Increment By, Decrement By)

**Store Property Action:** Stores an object property in a variable when a script is triggered. This can be useful if you need to trigger events based on embedded object properties or live data in a linked database. You can specify the objects (either by selection/search set or current selection), the variable to set, and the property category and property name (similar to how you specified these in the Find Items tool)

**Load Model Action:** Opens a file when a script is triggered. This file replaces the currently loaded model.

**The Scripting Workflow**

Creating scripts is pretty easy using the Scripter window. You first define scripts, optionally grouping them into folders. Then you define one or more Events (On Start, On Collision, On Hotspot, etc.) and set their properties, select objects in the scene and assign them to the Event triggers, then define Actions (Play Animation, Show Viewpoint, etc.) and set their properties.

To enable scripting to be expressed in the model, you need to ensure the Animations tab > Script Panel > Enable Scripting button is pressed. Once enabled, you can interact with your model, and scripted events will fire off the Actions. Note: When scripts are enabled, you cannot edit or create scripts in the Scripter window.
The Scripter Window

The Scripter window looks complex but it is actually very easy to use:

Continuing on with our “entry door” example, we first need to create different animations than in the previous example. That’s because those animations opened then closed the doors after a period of time. We want our animation to be event driven, that is, to open the doors when we come near them, and then close the doors whenever we go away, not on some timer. A single animation that does both will not work.

To close the doors, our script will simply run the “open doors” script in reverse, which we can do with a Hotspot event. This actually works better than an On Collision event, because it is flexible in terms of radius and how it triggers. Collision simply triggers when one thing hits another, and uses the internal collision detection mechanism, whose radius is adjustable in the Options > Viewpoint Defaults > Collision > Default Collision dialog box. Hotspot events have their radius configurable right in the Scripter Properties pane.

First, create an animation scene that just opens both outer doors, and another one that opens the inner doors. You still have to create 4 separate animation sets as before because there are four doors, but only need two keyframes for each: one at the start, and one at the end – say, at the 00:03 mark.

Note that you can copy and paste Scenes and Animation Sets, making the process easier.
In Scripter, we perform the 4 basic tasks: Add scripts, add Events to each script and customize their properties, select the objects in the scene and assign them to the Events, and add Actions to each script and customize their properties.

Start by adding a script by right-clicking in the window or clicking the Add New Script button. Name it Outer Doors Open. Do the same for Outer Doors Close, Inner Doors Open, and Inner Doors Close. Select the Outer Doors Open script.

In the Events window, pick the On Hotspot event type from the icons at the bottom. Select both of the outer doors in the Scene View (Set your selection resolution to First Object to select the entire set of outer doors). In the right hand Properties pane, select the following parameters: Hotspot = Sphere on Selection; Trigger when Entering; Selection --> Set from Current Selection; and Radius = 4 ft.

In the Actions area, click the Play Animation action button to add it. In the Properties pane, set the following parameters: Animation = Outer Doors; Pause at end = Checked; Starting at Start; Ending at End. This opens our doors.

We repeat the above steps for the Outer Doors close script: select the outer doors, add an On Hotspot Event, and add a Play Animation Action. The difference here that the On Hotspot event has Trigger When = Leaving, and the Play Animation action has Starting at End and Ending at Start. This has the effect of closing the doors. Edit the scripts for Inner Doors Open and Inner Doors Close in the same manner.

When finished, go to the Animation tab and Enable Scripts. Go to the View tab and split the view vertically, and in one view restore the Entrance 1 saved viewpoint. Activate the other scene, and walk through the doors. You should see them open as you pass through them. When finished, uncheck Enable Scripting so you can edit your scripts again.
Presenter

The Presenter module provides an easy to use interface to assign materials, lighting, environments, rendering effects, and RPC content to your scene, and allowing you to create photorealistic rendered images.

Presenter’s rendering capabilities are, in today’s terms, fair to midland, to be honest. We’ve all seen what kind of excellent photorealistic images we can get in Revit, Maya, and 3ds Max. Navisworks’ Presenter module is rather behind the times in that context. However, Presenter provides more than enough realism so that you may not have to buy those advanced tools (and figure out how to learn them!) for the occasional presentation and marketing pieces.

Presenter’s primary benefit is its drop-dead-easy user interface. It simply could not be easier to pick assets such as materials and lighting schemes from the provided library, bring them into your model’s palette, and drop them onto objects in your scene. Editing materials, lighting and other content is equally as easy, with simple dialog boxes provided for editing parameters.

Presenter is more than just making pretty pictures for a brochure; you can interactively set the materials, lighting, and environment in your model before you do anything else, such as perform design review tasks, TimeLiner simulations, or perform Clash Detection. Presenter can be used for OpenGL interactive rendering while you are navigating your model. Once you set up your scene with Presenter, you can view materials and lighting in real time. Indeed, it is as a utilitarian scene fixer-upper that it provides much of its value.

The Presenter Window

![Presenter Window](image)

The Presenter window has seven tabs across the top, and two panes below. The seven tabs are used to view, select and apply a variety of material and lighting to the model.

**Materials:** A wide variety of materials is included with Navisworks, which can be selected and applied to individual or groups of model items. New materials can be created and existing materials customized.

**Lighting:** Includes various lighting studios and lighting options that can be applied to the model. Lighting options can be customized.

**RPC (Rich Photorealistic Content):** Add images from various sources, including websites, to add entourage such as people, trees, cars, and so on.
**Effects:** Includes a variety of backgrounds and environments which can be applied to your scene. Additional backgrounds can be added from sources such as websites.

**Rendering:** Includes rendering styles which affects the way a scene is rendered. Customizable.

**Texture Space:** Defines the way in which a texture map is applied to a model item, e.g. a cylindrical texture space applied to a tank will provide a more realistic appearance.

**Rules:** Applies materials to models according to user-defined criteria. This is mostly used to speed up the process of applying materials to many items at one time.

**Archives**

When using the Materials, Lighting, RPC, Effects, and Rendering tabs, the left pane of the window contains three predefined Archives that are installed with Presenter.

- **Recommended** archives contain materials, lighting, effects and rendering styles (but not RPC content) that are used for interactive navigation. These items can be rendered with OpenGL and will appear best when rendered with one of the photorealistic settings.

- **Standard** contains additional materials, light studios, effects, RPCs, and render styles. These materials cannot be fully reproduced by the OpenGL graphics API that Navisworks uses for graphics display, and cannot be seen properly in interactive (Full Render) mode, but will display in the full renderings.

- **Templates** contains instances of each type of material, light, effect, and render style, giving you easy access to building your own photorealistic assets.

Archives are provided as LWA files. Additional LWA files can be downloaded from [http://www.lightworks-user.com/](http://www.lightworks-user.com/) and added to the Materials, Lighting, Effects, and Rendering tabs. Log onto the site, create a profile with a username and password, and have access to hundreds of free materials, lighting, RPC assets, and so on.

Once you have your materials, lights, effects and so on added to the model Palette, you can edit them simply by double-clicking on them. They are saved with the scene in an NWF or NWD file. Save any user-generated assets in the Users archive. Simply drag from the palette to the User archive of your choice. You can right-click on a user archive and select Save Archives to save it to disk. You can right-click on a material in the right (Palette) pane and copy the material to the clipboard, delete it, apply/remove the material from the scene, Select all Instances, and other options. Refer to the online help for advanced materials handling, e.g. saving your own edits to materials in an NWP file.

**Project Palette**

The right pane is your project’s palette. Any item placed here can be added to your model. The palette serves as place where you can customize materials, lighting and so on, without disturbing the Archives themselves. If you drag an item from the archives directly into the scene, it appears in the palette.

**Applying Materials**

Applying materials to model objects could not get much easier. You select the Materials tab, browse for the material you want from the archives, drag it to the right pane, and release the mouse button.
Applying a material to the model is similarly a simple drag and drop affair; drag the material from the right pane onto the model item and release. You do not have to select the model item beforehand. The appropriate texture mapping is applied automatically. To apply materials to multiple items, select the material to be applied, click on the first target model item, then hold the CTRL key down and click each additional item the material is to be applied to, then release the CTRL key. Press the ESC key to clear the selection of items and view the results. Note: Materials are applied based on the current Selection Resolution.

Alternatively, you can select the items first, right-click on the material in the right pane, and select Apply to all instances of Selection. Of course, you can use any means of selecting objects to apply materials. Use the selection tree and selection/search sets to select multiple items. You can also drag a material right to the object in the selection tree or search set. As with the Scene View, you can select the material, then use the CTRL or SHIFT keys in the Selection Tree to select multiple model targets. You can also right-click on those items and select Apply to Selected Items.

To remove a material from an object, right-click on the item or its listing in the Selection Tree. Click Presenter > Remove Material. To remove it completely from the scene, right-click on the material, and select Remove from all items.

**Materials, Lighting and Render Mode**

It’s important to understand that, as easy as Presenter is to use, the viewpoint you see is a very dumbed-down version of what the materials and lighting actually look like, particularly if you use items from the Standard archive. Click the Render button at the bottom of the Presenter window to see your scene come alive.

The “Full Render” render mode (Viewpoint > Render Style) will display with smooth shading and include any materials you have applied with Presenter.

You may notice that switching viewpoints loses the background or materials. The render mode is saved on a viewpoint by viewpoint basis; enable Full Render mode to see all of the Presenter effects.
Applying Lighting

Lighting is applied a little differently. The Archive provides individual lights as well as complete light “studios” which are combinations of lights that (generally) work well together. In almost every scene you would create for a rendering, you will use a combination of light studios along with placed individual light sources.

You can choose from six light types that will appear in both the interactive Scene View and in renderings. Each light type provided has several parameters that you can adjust to tweak, such as Intensity, Location, Fall Off, whether it cast shadows, shadow map parameters, color temperature, and so on.

Note that some of these are typically included with studios, or are “scene wide,” that is, you do not place them specifically in a scene.

**Ambient**: Applies a general background light. Most scenes require at least an ambient light source. It only has Intensity and Color parameters.

**Distant**: Directional lights which have a location and a target. The location/target only specifies the axis on which the light shines; the light is actually infinitely far away and the rays are always parallel. Along with Intensity and Color parameters, Distant lights can cast shadows in renders.

**Eye**: These lights are located at the viewpoint and simulate light from a headlamp, illuminating elements directly in front of you.

**Point**: Have a location but shine in all directions. They can cast shadows in a photorealistic view. Due to the omnidirectional nature of point lights, they consume a lot of resources when rendering a scene and can lengthen render times dramatically.

**Spot**: Spot lights are directional like Distant lights, but have a specific position in the model and include parameters for the light’s Fall Off and Cone Angle.

**Sun**: Simulated the sun’s light, whose position is defined by the Azimuth and Altitude in relation to your model’s North and Up directions. If the sun’s Mode includes Position, you can specify the location of the project model on the earth’s surface, the time (using local time zones) and date, and Presenter will calculate the Azimuth and Altitude for you. You can also have Presenter calculate the sun’s Intensity based on position, time of year, and atmospheric conditions.

In addition, you can specify three additional light types which appear in photorealistic renderings only. While effective, these lights can significantly add to the rendering time for your scene:

**Projector** lights project an image onto surfaces, such as a gobo or movie screen.

**Sky** lights simulate illumination from the sky, but not the direct contribution from the sun itself.

**Goniometric** lights can emit light based on industry standard files that define intensity distribution, such as CIE, IES, CIB, and LDT file formats.

To place lights in the scene, simply drag a studio light effect from the left pane to the right and it is applied to the model. To position Point, Distant, Projector, Spot and lights, you can use the physical gizmo provided in the scene. To position it more accurately, edit their Location parameter.

Note: It is recommended that you first start by only using the Environment Light Studio or the Standard Light Studio effect found in the Recommended folder. This is a quick way to apply predefined lighting to a scene that will almost always work well enough. Adding additional light
effects such as Ambient, Distant, Point, Eye, and Spot lights will most likely require additional adjustments. Refer to the Help section on Lighting for additional information.

You can enable or disable light effects individually to experiment with combinations of effects. As with materials, lighting in the viewport is only an approximation of the final rendered product. Perform a test rendering to get an idea of the actual finished lighting effect.

For a great explanation of the lighting component of Presenter, I recommend Jason Dodd and Scott Johnson’s book *Mastering Navisworks Manage 2012*.

**RPCs**

RPCs are premade image assets which can be added to your scene. There are only a few RPCs available, but much more are available online at [http://lightworks-user.com](http://lightworks-user.com).

Inserting an RPC is the same as a material; drag it from the archive into the palette, and drag it onto the scene. The RPC will appear after a brief delay. When you right-click on an RPC, you will get the option to move it to a new position.

Note that there is a problem with the provided RPC content. You may at first notice that they are not showing up. The problem is that the path to the RPC content is set to be relative, not absolute, so Navisworks cannot find the actual image content.

To fix this, double-click on the RPC content to edit its parameters. The File Name is something like `textures\RPC\[Name of Content].rpc`. This needs to be changed to the full path, which is `%ProgramFiles%\Autodesk\Navisworks Manage 2012\presenter\lads\layla_data\textures\RPC\[Name of content.rpc]`

To save this for future projects, pull in all of the RPC content, edit each one to the correct path, and drag them into the My RPCs folder.

**Adding Background Effects**

Similar to Materials, background effects are simply images that are applied as environmental backgrounds to your rendered scene. Drag and drop a background into the right pane and it is automatically added to the scene. Any background effect you added previously is removed.

**Rendering Effects**

Rendering Effects specify the rendering quality level for your scene. You can select a low quality fast rendering effect for testing and to experiment with materials and lighting. You can then select a high quality photorealistic rendering effect for the final renderings.

Renderings can be exported from the Navisworks application menu > Export > Rendered Image or via the Output tab. The export Rendered Image dialog has standard parameters and controls for selecting output file type, resolution, and path.
Bringing it all Together:
Linking TimeLiner, Animations, and Clash Detective

Navisworks’ TimeLiner provides the gateway to adopting a Virtual Design and Construction (VDC) methodology, where you use 3D modeling software to design and evaluate the construction process before actual construction. This involves some additional, simplified modeling of the overall site plan, site equipment, work packages, materials and so on – mostly with very little detail, or as semi-transparent boxes. You can do this easily with programs such as in AutoCAD or SketchUp, add this construction site model to your overall building model, and interplay with those 3D items.

VDC can be explored in Navisworks by combining the functionality of Animator, Clash Detective and TimeLiner. By doing so you can pre-visualize the construction site processes, and leverage tools to better plan the entire construction phase. You can combine Navisworks tools in the following manner:

Linking **Object Animation with TimeLiner** together enables the scheduling of object movement based on start time and duration of project tasks. This allows you to visualize the entire schedule in a dynamic manner as you animate the actual construction process. For example, you can schedule and animate the erection of the first floor steel structure, the migration of scaffolding and formwork from one floor to another, and other critical construction site processes.

When visualizing the entire site process you can also look for potential problems. By modeling and animating work crew packages based on the project schedule (typically as semi-transparent boxes in applications such as SketchUp or AutoCAD), you can visualize site coordination issues and revise the schedule accordingly. In this way, site planning can be visualized, identified and resolved long before going to site.

However, many such conflicts may escape the keenest eye. Since Navisworks Manage has the Clash Detective, we can use it to identify clashes automatically.

Linking an **Object Animation to Clash Detective** gives you the ability to perform “soft clashing” of objects, to automatically check for interferences between moving objects in the same Animation Scene. For example, you could have a single animation that moves dump trucks, forklifts, and other vehicles around the site as construction progresses. By linking that animation scene in the Clash Detective you identify where things can potentially run into each other. Note that you cannot clash two separate, independent animation scenes.

Linking a **TimeLiner schedule and Clash Detective** allows for static time-based clashing, that is, if you include static model representations of construction and temporary site items, such as work packages, crates, cranes, installations, lay-down areas, and so on, you can link those items to your TimeLiner schedule, and they can appear and disappear at particular locations at particular times. It is possible that some static package objects could take up the same space as some other static object at some time in the schedule. That can be registered as a clash in Clash Detective.

Linking a **TimeLiner schedule with animations with Clash Detective** together enables comprehensive time-based clash checks on the project. If the workgroup packages discussed above are modeled (typically, just as semi-transparent boxes) and animated, then placed on site driven by the schedule, the scheduled (but inadvertent) collision of the two can be recorded in Clash Detective.
Adding Animations to TimeLiner Schedules

You can link object and viewport animations to your construction schedules and bring life to your simulations and provide for a full VDC approach. For example, you can start your simulation with an overall blank construction site, then show the initial site preparation, such as fencing going up, the placement of site trailers, lay-down areas, trucks entering the site, and the rise of cranes. Then add animations of the individual building tasks, such as steel erection and the exterior envelope taking shape.

Add a Saved Viewpoints Animation to an entire schedule

You can add an animation to the entire schedule. These are limited to viewpoints, viewpoint animations, and camera animations. That would allow you to view your simulation while performing a walk-through around the building. It may be useful to create a simulation-specific animation that focuses on areas of the building at the same time as the tasks in those areas are being performed.

In the TimeLiner window, click the Simulations tab > Settings. In the Simulation Settings dialog, select the Animation drop down to link a saved viewpoint animation or a camera animation to the simulation.

Adding Object Animations and Scripts to TimeLiner

The animation that you can add to individual tasks in TimeLiner is restricted to scenes and animation sets from the scenes. Even though you specified a specific time for the duration of the animation, by default, the time scale for an animation added to a task is scaled to fit the task duration. In the Animation Behavior column you also have the option of specifying the animation to play at its normal (recorded) speed, by matching its start or end point with the task. Note to have “real-world” animations timed correctly you would need to set their keyframes and time in the Animator scene to match the length of the intended task.

Note: Animation keyframes may contain transparency and color overrides. During the TimeLiner simulation, the transparency and color override data from Animator are ignored.

To add an animation to a task, go to the Tasks tab and configure the columns to show Animations, Scripts (optional) and Animation Behavior. In each task to which you wish to add animation, and edit the Script, Animation and Animation Behavior columns as appropriate.
Adding Scripts is done in the same manner; enable the Script column (not shown above) and add the desired script. However, when you add scripts to TimeLiner tasks, the script events are ignored, and the script actions are run regardless of the events in the scene. However, the Actions specified in the script enable you to control how the animation will play (forwards, backwards, a segment at a time, and so on). You can also use scripts to change the camera viewpoints for individual tasks, or play several animations at the same time. **Note:** Before you simulate our schedule, be sure to enable animation scripts in your file, by clicking the Enable Scripts button on the Animation tab > Scripts panel.

### Linking Object Animations to Clash Detective

Performing “soft clashing” of moving and static objects is very easy. Create an Animation Scene with the objects to test – say, a bulldozer and a forklift which may cross paths. In the Clash Detective, in the Link pull-down, select the animation scene.

When run, the Clash Detective will record the position at each interval and register if any clashes are present.
Linking Your TimeLiner Schedules to Clash Detective

By itself, simple animation clashing is not very useful, because it is not tied to the construction schedule in any meaningful way. To really see what is going on, we need to link the TimeLiner project schedule into the Clash Detective.

Linking TimeLiner schedules to Clash Detective tests is not difficult, but some preparation work needs to be done beforehand. You want to ensure you’ve created and appended in the required 3D geometry for each piece of equipment or “work package” on the site that encompasses the area/volume required. For work packages you can use simple boxes modeled in AutoCAD or SketchUp. Create the required selection sets that encompass all of the extra onsite geometry.

In TimeLiner, make sure that the static work packages are displayed, and that you have tasks set up for each work package with start and end dates (they can be created using linked schedules). Make sure you have task types created for each of those static work packages (e.g., WP1, WP2, and so on). Configure them with the proper Appearance Definitions.

Play the simulation to view the static work packages; check that they are in the correct location and over the correct period of time. Click the Task tab before opening Clash Detective to stop the simulation (this is important). Keep TimeLiner open as you work in the Clash Detective.

In the Clash Detective, in the Select tab, click the Sets tab in each pane. Select the work package selection set in each pane that you wish to clash test. In the Run > Link drop down list, select TimeLiner and click Start. Clashes between work packages as their tasks happen will appear in the Results tab.

In the Clash Detective, select the objects you want to test in the left and right panes. On one side select the objects for which you created the animation scene. In the Link drop-down, click the animation scene name, and in the Step field, enter the interval period in seconds that determines how often a clash test is made throughout the simulation. Click the Start button. Clash Detective will check each interval in the animation to see if there are any clashes.

Linking a TimeLiner schedule with animation is similar. First, create the Scenes and Animation Sets with the desired objects to animate using the Animator window. Link the animations to the particular tasks in the TimeLiner. Finally, link the TimeLiner, complete with object and work package animations, into Clash Detective.
Additional Implementation Thoughts

Hardware Considerations

If your current PC is over 24 months old, you most likely will want a new graphics workstation to properly handle Navisworks and other BIM-related applications like Revit. On large, complex models, the faster your CPU, the more RAM you have, and the better video card you have will definitely make a difference. With the complexity of operations you will need to perform, moving to Windows 7 64-bit Professional is now considered mandatory; this 64-bit operating system can handle over 4GB of system memory and is much more stable with applications like Navisworks. 8GB is considered a practical minimum amount of RAM for Navisworks; the more you have the better. Navisworks perhaps taxes your system a little less than Revit – but not by much.

Choosing a decent workstation-class video card such as an Nvidia Quadro is also highly recommended. Unlike almost all other Autodesk applications that use DirectX, Navisworks instead makes heavy use of the OpenGL graphics API, particularly in interactive views of your model. This means that your graphics card must have a proper OpenGL driver that is tested by Autodesk, and be able to handle graphics acceleration properly for optimum performance. With the large datasets of complex geometry you have with structure, ductwork and piping, having a powerful card that can handle complex geometric calculations is critical. Gaming cards like the Nvidia GeForce or Ati Radeon typically do not have very powerful OpenGL drivers, and tend to be only functional enough for compatibility but not optimized for heavy CAD or 3D use.

One of the important aspects to consider is that, at the time of this writing, Navisworks’ rendering engine is not multithreaded, so it does not take advantage of multi-core processors as does Revit and 3ds Max. For heavy rendering operations, some may find that exporting your Presenter data with the geometry, viewpoints, materials and lighting as an FBX file, then using a dedicated system for rendering in 3ds Max to be cost effective.

For more information about specifying hardware for Navisworks and Revit, please refer to my AU 2011 class, “AB4792 A Hardware Wonk’s Guide to Buying the Best 3D and BIM Workstations, 2011 Edition.”

Learning Navisworks

As with any new software, making an investment in Navisworks requires time, money, and a dedication to the BIM process to realize all that it can do for your project. For all of its power, Navisworks is actually one of the easier programs to learn; the curve is fairly shallow and you can quickly come up to speed on the majority of its feature set in about two days. With a little practice, you can fly around your model quite easily, and its powerful ability to disseminate complex 3D geometry easily means that you will quickly find value in working with it.

What takes longer is pushing the software to fully realize what you want to get out of it. Most people purchase Navisworks Manage for the Clash Detection feature; indeed, it is the only thing different between Manage and Simulate. However, many do not leverage the use of animations in their simulations or clash detections, because perhaps they think animating is not worth the effort. But because animation is fairly easy to use – once you know how – you may find yourself throwing animations in to add a new level of interaction with the model. The trick is to get over the learning hurdle and make the feature set work for you.

In total, it takes about two days of instructor-led training to understand all of the program’s functionality; learning on your own will usually take longer. The datasets provided in the class
materials contain much of the material needed to practice. However, from my experience you can best learn Navisworks using actual BIM project files, to really get a feel for how it is used in the real world.

After that, the next best source for information is in the Help file. Navisworks comes with an excellent Help system which is most useful. I also encourage you to seek out all of the other Navisworks and BIM related Autodesk University class sessions. Download the handouts and the screencasts; they are full of valuable ancillary information about how people are implementing this new technology in the real world and are seeing positive results.

There are some great Navisworks forums at Autodesk and AUGI.COM, located at http://forums.autodesk.com/t5/Autodesk-Navisworks/bd-p/372 and http://forums.augi.com/forumdisplay.php?f=924, respectively. Become a member of both forums if not already, and bookmark these links to get great peer-to-peer support; they are often monitored by Autodesk support personnel who will often chime in with solutions as well.

The number of blogs dedicated to Navisworks is currently a little thin, although many BIM-specific blogs also include information on Navisworks. Some good resources are:

http://navisworks.blogspot.com/
http://vircon.blogspot.com/
http://navis-infocenter.blogspot.com/
http://dwf.blogs.com/beyond_the_paper/

Thank You
As you can see, Navisworks offers a wealth of powerful options and opportunities to really explore your BIM models and site construction process in visual detail. I hope this class met your expectations and helped increase your understanding of this complex product. If you have any questions or concerns, please do not hesitate to contact me at the email provided below.

Regards,
Matt Stachoni
Senior AEC Applications Technical Specialist
CADapult Ltd
3 Mill Park Court, Suite A, Newark, DE 19713
(302) 733-0477 x121 Phone
(302) 547-0895 Mobile
matt.stachoni@cadapult.net
matt@stachoni.com
http://www.cadapult.net
Blog: http://www.cadapult.net/aecblog/
Empowering Design With Integrated Solutions